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FONCTIONNALITES GENERALES DU LOGICIEL ENDNOTE (VERSION X9)

A PROPOS D’ENDNOTE

EndNote est un logiciel de gestion bibliographique. Cet outil permet de créer une banque personnelle pour

conserver des références bibliographiques de publications et pour générer automatiquement des listes de

références et des bibliographies dans un document Word ou présentation PowerPoint.

Les informations des références bibliographiques peuvent étre importées de banques de données, de

fichiers PDF ou saisies manuellement.

Les principaux avantages sont :

Gratuité pour les étudiants, professeurs, chercheurs et employés de Polytechnique.
Téléchargement a partir du site Web de la Bibliotheque.

Styles prédéfinis : plus de 6000 styles prédéfinis facilitent la production de listes de références.
Lien avec le texte intégral : un lien « Open URL » permet de localiser ou d’accéder au texte
intégral d’un article de revue.

Echange : son utilisation répandue dans le monde académique facilite I’échange de données.
Stockage Web : il est facile de sauvegarder une copie de votre banque dans un compte EndNote
Web et d’utiliser les fonctionnalités disponibles. Il est aussi possible de partager votre banque
avec vos collégues et produire des listes de références.

Production automatique d’une bibliographie dans un document texte ou présentation
PowerPoint.

Nouveautés EndNote X9 :

Partager votre bibliotheque avec des acces read-only ou read-write ;

Dans votre bibliothéque EndNote, afficher la liste des groupes partagés avec d'autres
utilisateurs dans votre compte EndNote Web ;

Obtenir des suggestions des revues ou vous pourriez soumettre votre article avec la fonction
Manuscript Matcher ;

Grace a I'abonnement de la Bibliotheque, déterminer l'impact et la pertinence d'un groupe de
références en produisant un rapport de citations dans Web of Science ;

Accéder a la source Web of Science ou aux références connexes des références dans votre
bibliotheque EndNote;

Nouveaux types de références : Social Media, Discussion Forum, Multimedia Application et
Television Episode;

Certains types de références ont été mis a jour.
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INSTALLATION DU LOGICIEL ENDNOTE

EndNote X9 est disponible pour téléchargement a partir de notre Guide EndNote qui comprend aussi des

informations relatives aux filtres d’'importation et aux fichiers de styles.

La Bibliotheque a également congu un guide qui détaille, pas a pas, les étapes d’installation pour un poste

personnel doté d’Office 2007/2010/2013/2016.

Il faut prévoir la mise a jour des fichiers d’importation et de styles a une fréquence d’environ une fois par

année.

TYPES DE FICHIERS

Le tableau suivant présente les principales extensions des fichiers inclus dans EndNote.

Banque de données : nom.enl Ex. : Demo.enl

Banque de données : nom.enlx

L'extension .enlx indique que les données et Ex. : Demo.enlx

les index sont comprimés dans un seul dossier.

Index + fichiers images : nom.Data Ex. : Demo.Data

Styles bibliographiques : nom. ens Ex. : APA 6th_fr_PolyMTL.ens
Filtres d’importation : nom.enf Ex. : ProQuest PolyMTL.enf
Gabarits pour rédaction avec Word : nom.dot | Ex. : App Phys Letters.dot

Note : Une banque EndNote peut étre transmise par courriel sous un format compressé (.enlx).
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https://guides.biblio.polymtl.ca/endnote
https://guides.biblio.polymtl.ca/c.php?g=479731&p=3280459

OUVERTURE ET AFFICHAGE

Ouvrir EndNote : Selon votre installation, suivre les étapes d’ouverture :
Démarrer = Toutes les applications = EndNote = EndNote
La fenétre de départ s’affiche. Vous pouvez créer une nouvelle banque ou ouvrir une banque existante.

OUVRIR UNE BANQUE EXISTANTE

Pour ouvrir la banque Sample_Library X9.enl :

1. A la fenétre de départ, choisir Open an existing library et sélectionner Sample_Library_X9.enl.
2. Si vous étes dans l'interface de EndNote, cliquer sur File et sélectionner Open Library. Ouvrir la
banque Sample_Library_X9.enl.

N, EndMote X9 - [Sample_Library_X%.enl]

EN, File Edit References Groups Tools Window

MNew...
Open Library... Ls Ctrl+0
Open Shared Library... Ctrtl+Shift+ 0
0 Ri t ,
pen Recen Le menu déroulant
Close Library Open Recent affiche jusqu’a
_ dix banques en ordre
dave décroissant de consultation
Save As... (la derniere banque ouverte
Save a Copy... apparaitra la premiére).
Revert
Share...
Export...
Import »
Print... Ctrl+P

Print Preview

Print Setup...
Compressed Library (.enkd ...

Bat Ctrl+Q
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CREER UNE NOUVELLE BANQUE

Pour créer une nouvelle banque :
1. Cliquer sur File et sélectionner New.
2. Choisir I'endroit ol enregistrer la banque et lui donner un nom.

¥/ EndNote X9 - [Sample_Library_X9.enl]
1 | File Edit References Groups Tools Window

/' New. [s

Open Library... Ctrl+Q ™, New Reference Library X

ST EES e 1 |5 » CePC » Documents > v O Rechercher dans : Documents 0O

Open Recent >

Close Library Ctrl+W Organiser v Nouveau dossier B o
™ Nom Modifié le L,

Save Ctrl+5 B3 CePC N MocHiEle D

Save As... B Bureau BookWhere 0:06 D

Save a Copy... | Docume! 2 Filtres EN 20 1:10 D ¥

e | Images v < >

ST Nom du fichier: | My EndNote Library.enl| ~

Export.. Type: EndMote Library (*.enl) v

Import >

Print... Ctrl+P My EndNote Library.enl

Print Preview (Nom proposé par défaut)

Print Setup... A Masquer les | Enregistrer Annuler

Compressed Library (.enk) ...

Exit Ctrl+Q

FERMETURE ET COPIE D’UNE BANQUE

e Pour fermer la banque : File 2> Close Library
e Pour faire une copie de la banque, avec ou sans les fichiers joints ou bien afin de la transmettre ou
de la joindre a un courriel : File > Compressed Library (.enlx)...

Compressed Library (.enlx) *
(®) Create (® with File Attachments
(O Create &E-mail (O without File Attachments
(®) All References in Library: Sample_Library_X9.enl
(O selected Reference(s)

(O all References in Group/Group Set: | Avian Intelligence

e

Sauvegarder dans le répertoire voulu. L’extension du nom de ce fichier sera .enlx.
A la réouverture de cette banque, le fichier .enl et le dossier .DATA seront recréés.
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AFFICHAGE DES BARRES ET DES CHAMPS

Barre de titre (Title bar)

Barre des menus (Menu bar)

B4, EndMote X9 - [Sample_Library_¥9.enl]

!

Barre d’outils (Toolbar)

Fenétre de recherche dans
la banque (Search Panel)

e File Edit References Groups Tools Window Help
O® | APABEN_Tr_PolyMTL - = AT | | 2] B} bE ‘ (7 Sk @ ‘ Quick Search Q - A Hide Search Panel
| My Library | search Options * Search Whole Library v| [(Imatch calle [ Match waords
All References (59) [Title <] [Contains -] | ¥ =] A
& Configure Sync..
|And v| |Year vHCl:mtains v| | Gl 0
4D Recently Added ()] =
B Unfiled ©) ® VYear Author Title Journal Reference Type  Last Updated "
T Trash © 2011 Fraser, O. N, Bugnyar, T.  Ravens reconcile after aggr.. PLoS ONE Journal Article 2013-03-22
Vick, S.; Bovet, D; Ande.. How do African grey parrot.. Animal Cognition Journal Article 2013-03-22
= Avian Intelligence 2010 Laudato, Anthony Bird grooves to the beat CBS Sunday Morning Online Multime..  2013-03-21
@ Avian Cognition  (31) 2009 von Bayern, A. M. P. Hea.. The role of experience in pr.. Current Biology Journal Article 2013-03-22
B corvids (19) 2009 Salwiczek, L. H; Emery, N.. The development of cachin.. Journal of Comparative Psych.. Journal Article 2013-03-21
@ Corvids & Parrots  (6) 2009 Pepperberg, Irene M. Alex & me: How a scientist .. Electronic Book ~ 2013-03-21
B parrots (24) 2009 New York State Departm.. Guidelines for conducting b... Government Do.. 2013-03-21
= Bats 2009 Emery, N.J; Clayton, N. S.  Tool use and physical cogni.. Current Opinion in Neurobiol.. Journal Article 2013-03-21
Bichi 2009 Clayton, N. S, Emery, N.J.  'What do jays know about 0.. Neurobiology of Umwelt: Ho..  Book Section 2018-09-24
EJC |r0pterf:: (16) 2009 Brinklov, S, Kalko, E. K. V... Intense echolocation calls fr.. Journal of Experimental Biology Journal Article 2018-09-24
=1 Echolocation “) 2009 Bird. C. D.: Emerv. N. J. Insiahtful oroblem solvina ... Proceedinas of the National A..  Journal Article 2018-09-24 A
@ Echolocation OR .. (6) | € >
'l:-SDnar A (5) Reference Preview @;.ttached PDFs @ b4
- My Groups Vick, S.J, Bovet, D, & Anderson, J. R. (2010). How do African grey parrots (Psittacus erithacus) perform on a delay of gratification task?
. Animal Cognition, 13(2), 351-358. doi:10.1007/510071-009-0284-2
£ Cognition-All (33)

= Find Full Text

Showing 59 of 59 references.

A

3

IE‘ Layout ~
$—

Barre d’état
(Status bar)

Fenétre de référe

Fenétre de groupes
(Groups Panel)

sélectionnée.

nces (Reference Panel) :

¢ Preview : Visualisation de la référence sélectionnée selon le style choisi;
o Attached PDFs : Affichage de(s) fichier(s) PDF joints a une référence

Barre d’outils

1 ® ‘ APABEh_fr_PolyMTL .
4

Style choisi

Layout permet de visualiser ou de cacher la fenétre de groupes (Groups
Panel) et d’afficher la fenétre des références (Reference Panel) a droite
ou en bas.

Recherche en ligne

Insérer une

EQISQA
t

Formater une
bibliographie

Nouvelle référence

citation
Importation des

références a partir des
banques de données
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AFFICHAGE DES CHAMPS D’UNE BANQUE

Il est possible d’afficher jusqu’a 10 champs (colonnes) des références dans la fenétre principale. La
configuration par défaut de EndNote X9 comprend les champs suivants :

e Lu/Nonlu
e Fichier joint
e Auteur

e Année de publication

e Titre

e C(Classement (Rating)

e Revue

e Date de mise a jour (Last Updated)

e Type de référence

® & Author Year

Title

™~

Un clic sur 'intitulé d’une
colonne déclenche le tri des
références selon ce champ.

Journal

e

Last Updated  Reference Type

Pour réorganiser les champs qui s’affichent, sélectionner l'intitulé de colonne respectif avec le bouton

gauche de la souris et le déposer a I'endroit désiré.

Pour modifier le nombre des champs affichés ou encore pour modifier les champs affichés :

e Sélectionner Edit, choisir Preferences et cliquer sur Display Fields.

e EndMote X9 - [Sample_Library_¥9.enl] EndNote Preferences
4, File Edit References Groups Tools Wind Change Case
® Undo Cirl+Z Display Fields
Display Fonts
. Cut Ctrl+X Duplicates
My Lib Find Full Text
CC[J}" Ctrl+C Folder Locations
Paste Ctrl+V Formatting
(e - — ; Libraries
& Con Paste With Text Styles PDF Handling
O Rece Clear Read / Unread
. Lo Reference Types
E_’ Unfi Select All Ctrl+ A Sorting
= Copy Formatted Ctrl+K Spell Check
i Tras . Sync
Find and Replace... Ctrl+R
Temporary Citations
= A\fi' Term Lists
N Font 2 URLs & Links
o, Size »
E_! C Style »
@ Output Styles >
E_” Imnport Filters ¥
Connection Files »
Nev Preferences... 1 ) EndNote Defaults

Aelds to display in the library window

Position Field

Column 1: | Read/Unread Status v

Column 2: | Year
Column 3: | Author

Column 4: | Title

Column 5: | Joumal/Secondary Title v

Column 6: | Reference Type
Column 7: | Last Updated
Column 8: | [Do not display]

Column 9: | [Do not display]
Column 10: | [Do not display]

v

v

Heading

il

al

eference Type

&1 7 5]

Updated

—

Note: Selectin

nteibmyw] Les intitulés des champs (headings)
peuvent étre personnalisés.

[ Display all 4
by

Revert Panel

Aaer
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ou

e Cliquer sur unintitulé de colonne avec le bouton droit de la souris et sélectionner les champs désirés.

B4 EndNote X9 - [Sample_Library_X9.enl]

4, File Edit References Groups Tools Window He
| @ APAGth_fr_PolyMTL - =
My Library | ® Year Authe
All References (59) 2009  Brink
& Configure Sync.. 2009 Clayt
4D Recently Added )] 2009 Emen
B Unfiled © | 2009 New
WTrash | 2099 Pep
2009 Salwi
=- Avian Intelligence 2009 wonE
@ Avian Cognition  (31) 2010 Laud
BiCorvids (19)
@ Corvids & Parrots  (6) 2011 Frase
Biparrots (24) 2071 Holzk
2011 Peppi
= Bats 2011 Pefc':r
Bl Chiroptera (16) 5011 Sefte
Bl Echolocation 4 2011 Smin
@ Echolocation OR ... (6) 2011 Smin
% Sonar (5) 2011 Zorin
= My Groups 2012 Goto,
% Cognition-aAll  (33) | 2°12 Pepp
2012 Schlc
=-Find Full Text 2012 Shan
2012  Shett
2012 Taylo
2012 Vonk

<
Reference  Preview
Vick, S. J., Bovet
Animal €

Showing 59 of 59 references.

ER T O T

-

v

v

-

Journal/Secondary Title
Date

Rating

Record Number
Reference Type
Secondary Authar
Place Published
Publisher

Volume

Mumber of Volumes
MNumber

Pages

Section

Tertiary Author
Tertiary Title

Edition

Type of Work
Subsidiary Author
Short Title

Alternate Journal/Title
ISBN/ISSN

Original Publication
Reprint Edition
Reviewed ltem
Custom 1

Custom 2

Custom 3

Customn 4

Customn 5

Customn &

Custom 7

Customn 8

Accession Number
Call Number

Label

Keywords

Abstract

Motes

URL

Author Address
Caption
Figure
Dol
File Ad
Translated Author

chments

P 5B (O

@ ‘ Quick Search

a -

v

3 Show Se,

- &8 X

arch Panel

echolocation calls fr...
Jjays know about o...
and physical cogni...
es for conducting b...
he: How a scientist ...
elopment of cachin...
of experience in pr..

oves to the beat

African grey parrot...

econcile after aggr...
al structure of New ...
gnition and social i...
tive problem solvin..
ene Pepperberg & ...
apability of birds fo...
umerical symbols b...
a on the brain and ..
lled crows (Corvus ...
c communication i...

rots use inferential...
n's connective core ...
als have insight, an...
edonian crows reas...
rd handbook of co..

Journal

Journal of Experimental Biology
Neurobiology of Umwelt: Ho...
Current Opinion in Neurobiol...

Journal of Comparative Psych..
Current Biology

CBS Sunday Morning

Animal Cognition

PLoS ONE

Animal Behaviour

Interaction Studies

Animal Cognition

NOVA Science Video Podcast
Biology Bulletin of the Russian...
Zoologichesky Zhurnal
Zoologichesky Zhurnal

Animal Cognition

The Oxford Handbook of Com...
Proc. R. Soc. Lond. B. Biol. Sci.
Philos. Trans. R. Soc. Lond. B Bi...
Canadian Journal of Experime...
Proceedings of the National A..
Oxford Library of Psychology

Reference Type

Last Updated A

Journal Article 2018-09-24
Book Section 2018-09-24
Journal Article 2013-03-21
Government Do.. 2013-03-21
Electronic Book ~ 2013-03-21
Journal Article 2013-03-21
Journal Article 2013-03-22
Online Multime.. 2013-03-21

Journal Article

201

Journal Article 2013-03-22
Journal Article 2013-03-21
Journal Article 2013-03-21
Journal Article 2013-03-22
Podcast 2013-03-22
Journal Article 2013-03-22
Journal Article 2013-03-21
Journal Article 2013-03-21
Journal Article 2013-03-22
Book Section 2013-03-21
Journal Article 2013-03-22
Journal Article 2013-03-21
Journal Article 2013-03-21
Journal Article 2013-03-22
Edited Book 2013-03-21 v

pw do African grey parrots (Psittacus erithacus) perform on a delay of gratification task?
0.1007/s10071-009-0284-2

[I=] Layout

TYPES DE REFERENCES DANS ENDNOTE

Il existe 54 types de références prédéfinis.

Cette liste apparait lors de I'ajout d’'une nouvelle référence ou lors de

I'ouverture d’une référence.

N, EndMote X9 - [Mew Reference]

N, File

Edit

References Groups Tools

Wind

4m m» Reference

T attached POFs | &2
EREE

0

Reference Type: [Journal Article

E

Le type de référence choisi
doit correspondre au type de
document que I'on veut
intégrer dans la banque.

Author

Year

Title

Journal

Film or Broadcast
Generic

Government Document
Grant

Hearing

Interview

Journal Article

Legal Rule or Reygulation
Magazine Article
Manuscript

Map

Multimedia Application
Music

Mawiznanar Artirla

~

9

Bibliothéque - Polytechnique Montréal — Septembre 2020



TYPES DE DOCUMENTS ET TYPES DE REFERENCES

Le tableau suivant représente les types de documents les plus fréquents en génie et les types de références
correspondants recommandés dans EndNote.

Types de références recommandés dans
Types de documents yp

EndNote
Article de revue académique imprimé ou électronique | Journal Article
Article d’encyclopédie ou de dictionnaire Encyclopedia
Brevet Patent
Communication a une conférence Conference Paper
Livre, dictionnaire ou encyclopédie (imprimé) BO.Ok

Edited Book
Livre en format électronique Electronic Book
Chapitre de livre, chapitre d'aide-mémoire Book Section

Chapitre de livre, chapitre d'aide-mémoire en format

, . Electronic Book Section
électronique

Norme Standard

Mémoire de maitrise ou thése de doctorat Thesis

Rapport technique ou gouvernemental Report

Site Web ou page Web Web Page
REFERENCES

Une référence comporte jusqu’a 52 champs dont certains peuvent étre personnalisés selon vos besoins.
Les données d'une référence devraient contenir les informations permettant de citer le document selon le

style désiré. D = R

« » Reference @
E| E | % | & |E wg| eainron - pansize | B I U P | AN A T B

T Attached PDFs

£

~
Reference Type: Journal Article - ‘r'lj -

Author v Show Empty Fields
Teeling, E. C. Show Rating Field
Springer, M. S.
Madsen, O.
Bates, P.
O'Brien, S. J.

Murphy, W. J.
Year Vous pouvez choisir

2005 .
Title d’afficher ou de cacher

A molecular phylogeny for bats illuminates biogeography and the fossil record les champs vides
Journal (Show Empty Fields).

Science

Volume
307

Part/Supplement

Issue
5709
Pages
580-584

w

Added to Library: 2010-05-05 Last Updated: 2013-03-21 Layout -
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OUVRIR UNE REFERENCE

Pour ouvrir une référence, EndNote X9 vous propose deux options :

e Double-cliquer sur la référence voulue pour I'ouvrir en plein écran

ou

e Sélectionner la référence et cliquer sur I'onglet « Reference ».
Les dimensions des différentes fenétres peuvent étre ajustées pour avoir un affichage convenable.

4, EndMote X9 - [Sample_Library_X9.enl] — O >
, File Edit References Groups Tools Window Help - 8 %
] @ ] | APAGth_fr_PolyMTL - E"_ @ & @ @ | B | E l_?} ['-EE | Q &r Qg - ® | Quick Search a - i
| My Library ® Year Author i Title Journal Reference Ty *
All References 2011 Zorina, Z. A; Obozova, .. New data on the brain and cognitive abi.. Zoologichesky Z.. Journal Article
@ Configure Sync... 2005 Zorina, Z. A Animal intelligence: Laboratory experim.. Zoologichesky Z.. Journal Article
ORe cently Added ) 2008 Yovel, Y., Franz, M. O.; S.. Plant classification from bat-like echoloc...
B} Unfiled ©) Wiegrebe, L. An autocorrelation model of bat sonar
T Trash ©) 2012 Vonk, Jennifer; Shackel.. The Oxford handbook of comparative e... o0.. Edited Book
ras
2009 von Bayern, A.M.P; H.. The role of experience in problem solvin.. Curt gy  Journal Article
- Avian Intelligence 2010 Vick, S.J; Bovet, D, An.. How do African grey parrots (Psittacus e.. Animal Cognition Journal Article
@ Avian Cognition  (31) 2007 The Alex Foundation, Alex the African grey parrot and subject ... Press Release
B Corvids (19) 2005 Teeling, E. C,; Springer, .. A molecular phylogeny for bats illumina.. Science Journal Article
@ Corvids & Parrots  (6) 20° ‘or, A. H.; Miller, R.; .. New Caledonian crows reason about hi.. Proceedings of t.. Journal Article
W
E_’Parrots 24 ” fa Tl T. M __ M.k LIRL P Sy PR el - PUNIPURG PPN T | RIS £ S P N NP o S DI U ——— [ [Ppp—— | A.J.!_)I.
(24) \
= Bats Reference | Preview '@Mtached PDFs | @ ¥
E—’ Chiroptera (1 6) Reference Type: Journal Article ~ ‘r'E‘l -0
Bl Echolocation ) || Author
@Echolocation OR .. (6) | wiegrebe, L.
3 Sonar (3) ||Year
=+ My Groups 2008
# Cognition-All  (33) |Title _
An autocorrelation model of bat sonar
=-Find Full Text Journal y

Showing 59 of 59 references.

|E| Layout =
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STYLES

Dans une banque, un clic sur une référence permet de la visualiser selon le style choisi, dans I'onglet
Preview.

B4 EndMote X9 - [Sample_Library_X9.enl] — O >
€4, File Edit References Groups Tools Window Help -
D@ APABER_fr_PolyMTL - l_gjr @ & @ @‘ = ‘ E @[\EE‘ Q fyo9y - @‘ Quick Search Q - g
My Library ® Year Author i Title Journal Reference Tyg *
All References (59) 2011 Zorina, Z. A; Obozova, .. New data on the brain and cognitive abi.. Zoologichesky Z.. Journal Article
& Configure Sync... 2005 Zorina, Z. A. Animal intelligence: Laboratory experim... Zoologichesky Z.. Journal Article
DRecently Added ) 2008 Yo-vel, Y.; Franz, M. O, S.. Plant classmcatl.on from bat-like echoloc... P-LOS (?omputatl... Journal Art!cla
B Unfiled % 2008 Wiegrebe, L. An autocorrelation model of bat sonar Biological Cyber.. Journal Article
7 Trash 0 2012 Vonk, Jennifer; Shackel.. The Oxford handbook of comparative e..  Oxford Library o.. Edited Book
ras
- von Bayern, A. M. P.; H.. The role of experience in problem solvin.. Current Biology  Journal Articld
= Avian Intelligence 2010 Vick, S.J.; Bovet, D; An.. How do African grey parrots (Psittacus e.. Animal Cognition Journal Article
@ Avian Cognition  (31) 2007 The Alex Foundation, Alex the African grey parrot and subject ... Press Release
Bl Corvids (19) 2005 Teeling, E. C; Springer, .. A molecular phylogeny for bats illumina.. Science Journal Article
@ Corvids & Parrots  (6) 2012 Taylor, A. H; Miller, R; .. New Caledonian crows reason about hi.. Proceedings of t.. Journal Article
Al T. M. _ N .k LI B Ny Nl B PP S, L S . U E ) PSR S —_—— [ JPpR—— | A.J.:_I.v
Bl parrots (24) |« - >
= Bats Reference ﬁ].ﬁttached POFs |@ ¥
E_!Chiroptera (15) ||von Bayern, A. M. P, Heathcote, R. J. P, Rutz, C, & Kacelnik, A. (2009). The role of experience in problem solving and
B Echolocation @) innovative tool use in crows. Current Biology, 19(22), 1965-1968. doi:10.1016/j.cub.2009.10.037
@Echolocation OR .. (6)
3 Sonar (5)
=My Groups
4 Cognition-All (33)

= Find Full Text

Showing 59 of 59 references. |E| Layout *

La commande Select Another Style... permet de sélectionner un

style parmi les styles disponibles sur votre poste. & EndNote X3 - [Sample_Library_X3.enl]

File Edit References Groups Tools W

APAGth_fr_PolyMTL -

Select Another Style...

My Libra Annotated
disponibles sous I'onglet « Styles et saisie » du guide EndNote de Y y APA Bth

o NS 2 s | APABEh_fr_PolyMTL
la Bibliotheque. _Authnr-Date

@Conﬁgure :::Iiiréié:agn 16th Footnote
Pour accéder a tous les styles offerts par EndNote, consulter leur 1) Recently A LEIEHEP:ETEEJIE#;I_LDEE]
B Unfiled gqr?t;nu:irlftliields

-@- Trash Ll.alrnacbcizzeﬂ;th Footnote

La Bibliothéque a adapté les styles APA 7th et IEEE pour
utilisation dans un document Word en frangais. Ces styles sont

site a I'adresse suivante :
https://endnote.com/downloads/styles/
OU faites Help = EndNote Output Styles

Sauvegarder les styles choisis sur votre poste au C:\Program Files\EndNote X9\Styles\.
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OUTILS POUR GERER VOTRE BANQUE

CREATION DE GROUPE &) EndMote X9 - [Sample_Library_9.e1 | 4
File Edit References Groups “te._Windc
2 jc
reate Group [/\\y‘
Jusgu’a 5000 groupes de références peuvent étre créés a l'intérieur™7"  Create Smart Group

Create From Groups...

d’une méme banque.
. Rename Group
1. Cligquer sur Groups. Edit Group...

2. Sélectionner Create Group. Delete Group

3. Nommer votre groupe. Share Group...

Add References To *

Remaove References from Group Ctrl+D

Un groupe ne fait que pointer vers un Create Group Set
sous-ensemble de références déja Delete Group Set

présentes dans la banque. T
Create Citation Report

Manuscript Matcher

Hide Groups

e, | 2008
Bl Chiroptera (15) 2008
Bl Echolocation 2 2007
@ Echolocation OR ... (6) 2009
3 Sonar
|New Group 3

CREATION DE « SMART GROUP »
1 | La fonction « Smart Group » correspond a des critéres de recherche

4, EndMote X9 - [Sample_Library_x%
B File Edit References Groups\' Tools  Wind
Create Group des groupes lors de I'importation ou des mises a jour des références.

Create Smart Group 2 ) 1. Cliquer sur Groups.

(stratégies de recherche) permettant de mettre a jour automatiquement

Create From Groups...

2. Sélectionner Create Smart Group.
Rename Group
Edit Group... 3. Inscrire le nom de votre « Smart Group ».
Delete Group 4. Entrer vos criteres de recherche.
HiET A 5. Cliquer sur Create.
Add References To > Smart Group %
Remove References From Group 3
Create Group Set Smart Group MName: |New Smart Group :
Delete Group Set |Author V| | Contains V| |Bi|05ki| \ =l =
Rename Group Set |And v| |‘r'ear v| | Contains v| | — 4 7| [
Create Citation Report |And v| |Tit|e v| | Contains v| [ = + |-
Manuscript Matcher
Hide Gmups Cancel Options... * [Omatch case  []Match Words

5
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CREATION D’UN ENSEMBLE DE GROUPES

Pour créer un ensemble de groupes :
1. Cliquer sur Groups.
2. Sélectionner Create Group Set.
3. Nommer votre ensemble de groupes.
4. Glisser dans votre ensemble les groupes a rassembler.

&, EndMote X9 - [Sample_Library_¥9.enl] ) EndMNote X9 - [Sample_Library_X9.enl
B4, File Edit References Groups

] (f;} | APAGER_fr_PolyMTL

BN/ File Edit References Groups Tronals

Create Group J
Create Smart Group ‘ My Library ‘
Create From Groups... B All References (59)
l"“.
Rename Group & Configure Sync...
Edit Group... D Recently Added (1
Delete Group Bl Unfiled (7
W Trash (0)
Share Group...
= Avian Intelligence
Add References To > . .
@ Avian, Cogr’ (31)
Remowve References From Group }
B Corvils (19)
Create Group Set h \’) @ Corvifls & Parrpts  (6)
Delete Group Set Biparr (24)

Rename Group Set

‘EINEW Group Set M ‘}
Create Citation Report

= Bats
Manuscript Matcher

Hide Groups
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SUPPRIMER DES REFERENCES

Quand des références sont supprimées, elles seront automatiquement envoyées dans la corbeille (Trash).

1. Sélectionner la (les) référence(s) a éliminer.

2. Cliquer sur I'onglet References.

3. Choisir Move References to Trash.

4. Pour vider la corbeille, choisir References = Empty Trash.

EndMote

Would you like to empty all recerds frem the Trash? This cannot be

! undone,

Cui

I

Mon

1

Choisir Oui pour vider
votre corbeille.

Choisir Non pour que les
références demeurent
dans votre corbeille.

ELIMINATION DES DOUBLONS

EndNote X9 vous permet d’identifier les doublons se trouvant dans votre banque et de comparer le contenu

des notices afin de choisir la meilleure et de la conserver.

Par défaut, les doublons sont repérés en comparant les champs « Author », « Year », « Title » et « Reference
Type ». Il peut étre utile de comparer seulement le champ « Title » puisque par exemple, les noms des

auteurs pourraient étre écrits différemment.

Pour modifier les paramétres de comparaison :
1. Cliquer sur Edit 2> Preferences.
2. Sélectionner Duplicates.

3. Décocher les champs « Author », « Year » et « Reference Type » = OK.
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B4, EndMote X9 - [Sample_Library_X9.enl]

&) File
O®
My Lib
& Con
ORece
B unfi

W Tras

Edit

= Aviz
@
Bic
@
Bir

References  Groups

Undo

Cut

Copy

Paste

Paste With Text Styles
Clear

Select All

Copy Formatted
Find and Replace...
Font

Size

Style

Cutput Styles

Import Filters

Connection Files

[

Preferences...

Pour comparer les doublons :
4. Cliquer sur References = Find Duplicates.

EndMote Preferences
Tools  Wind  Change Case
Ctrl+Z isplay Fields
.. Display Fonts
Ctrl+X 74 JEDuplicates,
- Find Full Text
Ctrl+C
T i Folder Locations
Ctrl+V .. Formatting
- Libraries
- PDF Handling
- Read / Unread
Crl+A - Reference Types
. - Sorting
Ctrl+K .. Spell Check
Crl+R - Syne
- Temporary Citations
¥ -.. Term Lists
. - URLs & Links
»
»
»
>

Compare references based on the following fields:
[ Author

[ Year

Title

[ secondary Title {Joumal)
1 velume

[ ls=ue
1 Panes

Criteria

O Exact Match

(®) lgnore spacing and punctuation
Online Search Results

[ Automatically discard duplicates

)

EndNote Defaults

Revert Panel Annuler Appliquer

5. Comparer le contenu des deux notices et choisir la meilleure.

6. Au besoin, faire les modifications nécessaires dans la notice a conserver. (Si les deux notices

comprennent différentes informations utiles, faire des modifications dans la notice a conserver

directement dans la fenétre de comparaison. Par exemple, vous pourriez copier-coller d’une notice a

I'autre un DOI dans une notice ou il n’était pas présent, mais qui contenait déja un ISSN et une adresse

URL.)

7. Cliquer sur Keep This Record du coté de la notice a conserver.

[Sample_Library_X9.enl]

References  Groups Teols
MNew Reference
Edit References

Move References to Trash

Go To..

Window Help
Ctrl+N
Ctrl+E
Ctrl+D
Ctrl+)

Copy References Te

E-mail Reference

File Attachrnents

PDF Viewer
Find Full Text

Find Reference Updates...

URL
Figure

Web of Science

Mext Reference
Previous Reference

Show All References

Ctrl+Page Down
Ctrl+Page Up
Ctrl+M

Show Selected References

Hide Selected References

Record Summary...

Find Duplicates

Restore to Library

Resolve Sync Conflicts...

Empty Trash

4 Find Duplicates

Comparing 1and 2 of 2 duplicates.
Select the record to keep., The r

Cancel

*+selected will be moved to the Trash. Select Skip to go to the next set of duplicates.

Journal
Current Biology

Volume
19

Part/Supplement

Issue

22

Pages
1965-1968

Added to Library: 2013-03-15

Last Updated: 2015-01-25

7 Keep This Record
3y won Bayern, 2009 ¢16 won Bayern, 2009 #2340
Ref Type: Journal Artice Ref Type: Journal Artice
Title ~ |Title
The role of experience in problem solving and The role of experience in problem solving and
N innovative tool use in crows innovative tool use in crows

Journal
Current Biology

Volume
5.6 Part/Supplement

Issue

Pages

Added to Library: 2019-01-28  Last Updated: 2019-01-23
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VERIFICATION DES REFERENCES

Aprés une importation de références provenant d’'une ou de plusieurs banques, vérifiez-les afin de vous
assurer que les informations importées sont compléetes et qu’elles ont bel et bien été importées dans les
bons champs. Ne pas oublier de retirer les doublons.

CORRECTION D’UNE REFERENCE OU CORRECTION EN LOT

Pour corriger une référence :
1. Ouvrir la référence afin de I’éditer en plein écran (double-clic sur la référence) ou bien dans I'onglet
« Reference ».
2. Lorsque les corrections sont faites, sauvegarder en cliquant sur le X de la fenétre en mode plein écran
ou en cliquant sur une autre notice en mode « Reference ».
3. Choisir « Yes » dans la boite de dialogue.

[Sample_Library_X9.enl]
References  Groups Tools Window Help

Mew Reference Ctrl+N
& ®
Edit References Ctrl+E

Pour la correction en lot :

1. Sélectionner les références a corriger. e e it
Go To... Ctrl+)
2. Afficher ces références avec References = Show TS >
E-mail Reference
Selected References. -
File Attachments 5 Plant classific
; ; : PDF Vi An autocorre
Ensuite, deux options sont possibles pour effectuer des e ’ e
Find Full Text > Shackel.. The Oxford h
changements dans ces références : Find Reference Updates.. M.P.H.. The role ofe:
E_RL " M.P;H.. Theroleofe:
>
e , D, An..  How do Afric
B s ’ ation, Alex the Afrig
Mext Reference Ctrl+Page Down ringer. .. A molecular
Previous Reference Ctrl+Page Up ler. R.: New Caledor
Show All References M .
Show Selected References L\\, 2 ) R.S;M.. ngh bat {Ch
Hide Selected References Use Of numEj‘
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Option 1 : « Find and Replace... »

Pour chercher une chaine de caractéres en particulier et la remplacer par une autre.
3. Poursuivre avec Edit - Find and Replace...
4. Dans la liste Select a field..., choisir le champ ou effectuer des corrections.
5. Inscrire le texte a changer dans la boite Find :.
6

. Inscrire le texte de remplacement dans la boite Replace with: puis cliquer sur Change.

ite X9 - [Sample_Library_x9.enl]
Edit References Groups Tools Wing

Unde Ctrl+Z )
Find and Replace *
Cut Ctrl+X

Copy Ctrl+C
Paste Ctrl+V
Paste With Text Styles Find:

In: |5ele-:t a field... 4 Insert Spedial *

Clear

Select All Ctrl+A

Copy Formatted ~ ¥

Find and Replace... I} \
3 )

Font / Replace with:

Size >

Style >

[IMatch Case Match Words

Output Styles >
Import Filters > Retain Capitalization
Connection Files ]

Cancel

£l

i
=]
1]

Preferences...

Option 2 : « Change/Move/Copy Fields... »

Pour modifier un champ pour toutes les références sélectionnées. Par exemple, afin de bien organiser sa
banque de références, nous recommandons d’utiliser cette fonction des I'ajout de nouvelles références pour
inscrire le nom de la base de données de laquelle proviennent les références et la date a laquelle les
références ont été ajoutées.

3. Poursuivre avec Tools 2 Change/Move/Copy Fields...

4. Dans la liste In: Select a field..., choisir le champ oU effectuer des corrections.

5. Choisir le type de modification a faire et écrire le texte a insérer dans la fenétre de droite.

6. Cliquer sur OK.

Tools  Window Help

Change/Move/Copy Fields X

Search Library... Ctrl+F 9e oy
Spell Check Ctrl+Y Change Fields  Move/Copy Fields 4
Cite While You Write [CWYW] ¥
Online Search... In: | Mame of Database > Insert Spedal *
F t P

ormat Paper 3 m - '
Change/Move/Copy Fields...

d B l} ~ ¢ (O Insert after field's text: Compendex 2019/01/28

S

yne (D) Insert before field's text:
Open Term Lists > (® Replace whole field with:
Define Term Lists... Ctrl+4 O Clear field
Link Term Lists... Ctrl+3

N T8I LIsts i () Change case
Sort Library... \ Sentence case. J
Recover Library...
Find Broken Attachment Links... Indude a space before the new text B I U P Al AJ_ Z

Indude a space after the new text -

Library Summary...
Subject Bibliography... 6 OK [N Annuler Aide

Manuscript Templates...
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QUELQUES FONCTIONNALITES DE RECHERCHE DANS VOTRE BANQUE ENDNOTE

Il est possible de choisir tous les champs ou un champ spécifique pour exécuter une recherche. Il vous suffit
d’utiliser la fenétre supérieure de I’écran principal et sélectionner I'onglet Search ou par la commande Tools
-> Search Library...

La recherche s’effectue dans toute la banque a moins d’avoir préalablement sélectionné des références.

€N, EndMote X9 - [Sample_Library_X9.enl] — O
e File Edit References Groups Toels Window Help
— — ) »

® | APAGEh_fr_PalyMTL - = AT | [»] B EUE| () S . ®‘
My Lib rary I |'\ I Search [:I Options * | Search Whale Library V| [IMatch Case []Match Words
B All Referenfles (60) [Author <] [ Contains v] |rutz -

|And V| |‘fear v| | Contains V| | =M=
& Configure Sync..
@Recently Added {2) |And V| |Author V| | Contains V| | +| |-
B unfiled (10) = :
 Trash © ® Year Author Title Journal
if Tras
- 2009 von Bayern, A. M. P; H.. The role of experience in problem solvin.. Current Biology
=- Avian Intelligence

Match Case : lors de la recherche, la casse des caractéres (minuscules et majuscules) est considérée (ex. :
une recherche sur le terme 3d ne repérera pas 3D).

Match Words : recherche les mots exacts (ex.: une recherche sur le terme position ne repérera pas
positioning).

Note : Par défaut, la troncature est appliquée a gauche et a droite du terme de recherche.
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ALIMENTATION DE LA BANQUE ENDNOTE

SAISIE MANUELLE

Pour saisir manuellement les données d’une publication :
1. Choisir References = New Reference ou cliquer sur I'icbne

El

de la barre d’outils.

2. Choisir le type de document correspondant a la publication (Reference Type).

3. Compléter les champs en respectant les recommandations de saisie.

4. Sauvegarder en cliquant sur le X et sur « Yes » dans la boite de dialogue qui s’ouvrira.

_ [Sample_Librar}r_Xg.enI] B4, EndMote X9 - [New Reference]

I UP| A A Z -

* Plain Size - B

e, File Edit References Groups Tools Window Help
Refi G Tools  Wind Hel
= roups — g EP Reference @—tta:he-ﬂ PDFs @
New Reference Ctrl+M
\ E‘ QD‘ E‘ E\l ""'Ennt

Edit References [} Ctrl+E | | | | ‘ 7 EI
Move References te Trash Ctrl+D Reference Type: Journal Article A 2
Go To... Ctrl+) ‘Author
Copy References Te » Year
E-rnail Reference
File Attachments ¥ Title
PDF Viewer ¥

Journal
Find Full Text > 3
Find Reference Updates... Volume
URL »
Eimura \ Part/Supplement

| PPN

L’onglet « Styles et saisie » du guide EndNote indique les informations obligatoires a inclure dans une

référence.
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CONNEXION DIRECTE

La connexion directe permet d’'importer des références provenant de catalogues de ) EndNote X0
bibliotheques. Les fonctions de recherche sont limitées puisque l'outil combine o File Edit
I'interface de recherche EndNote et certaines fonctions du catalogue de bibliotheque

interrogé. Cette fonctionnalité convient aux recherches simples. On vous recommande I-—_l @ |

le mode de recherche Online Search Mode (Temporary Library) pour la connexion directe. Pour ce faire, il

faut cliquer sur le globe terrestre de la barre d’outils.

IMPORTATION DIRECTE

L'importation directe consiste a ouvrir un fichier de notices directement a partir d’'une banque de données
bibliographiques, sans utiliser de filtre. Certaines banques de données offrent dans leur interface I'option
de télécharger dans EndNote des notices sélectionnées lors d’'une recherche dans cette banque. Il s’agit
d’une opération simple et rapide.

Par contre, il faut faire tres attention de vérifier les notices importées puisque les informations ne se
retrouvent pas toujours dans les bons champs. La Bibliothéque a produit des procédures d’importation pour
différentes banques de données tres utilisées a Polytechnique. Nous y avons indiqué pour quelles banques
de données nous recommandons d’utiliser 'importation directe. Ces procédures se trouvent dans la section
« Filtres et importation » du guide EndNote.

IMPORTATION INDIRECTE

L'importation indirecte consiste a télécharger sur son ordinateur un fichier de notices .ris a partir d’'une
banque de données bibliographiques, puis a importer ce fichier dans la banque EndNote en y appliquant un
filtre approprié. Pour savoir quel filtre choisir et pour avoir les détails des procédures d’'importation pour
différentes banques de données tres utilisées a Polytechnique Montréal, consulter la section « Filtres et
importation » du guide EndNote.

De plus, la Bibliotheque a développé des filtres pour les principales banques utilisées a Polytechnique
Montréal pour lesquelles I'importation directe comporte des erreurs. Voir I'onglet « Filtres et importation »
du guide EndNote.

Sauvegarder les filtres désarchivés sur votre poste au C :\Program Files\EndNote X9\Filters\.
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IMPORTATION MANUELLE DE FICHIERS PDF

A partir d’un fichier PDF enregistré sur le poste de travail de 'usager, EndNote peut créer une nouvelle
référence et lui joindre le fichier PDF respectif. Les informations bibliographiques de base seront ajoutées
automatiquement dans la référence.

ATTENTION! Les fichiers PDF provenant des banques de données pour lesquelles la Bibliotheque
a des abonnements peuvent étre enregistrés pour usage personnel seulement. Il n’est pas permis
de sauvegarder des fichiers PDF sur un serveur afin de donner accés a ces fichiers par les membres
d’un groupe de recherche.

Pour qu’EndNote puisse effectuer I'importation, le PDF doit comprendre un DOI (Digital Object Identifier).
La fagcon dont le DOI est mentionné dans les deux premieres pages du document détermine le succes ou
I’échec de I'importation.

Voici trois situations ou 'importation s’exécute correctement :

Upgrading Biomass Fast Pyrolysis Liquids

Anthony V. Bridgwater

Bioenergy Research Group, Aston University, Birmingham, United Kingdomy; axbric

ac.uk (for correspondence)

Published online 5 April 2012 in Wiley Online Library (wilevonlinelibrarz.com})

dependéncu_ Gahk et al. showed that it was possible 'to train Rhodospirillum rubrum [5] and Rhodopsendomonas
palustris [6]) have additional nitrogenases consisting of
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Revised:  March 14, 2012
Published: March 20, 2012

16 e doierg/10.1021/e43001339 Lplergy Fuels 2012, 26, 2416-2426
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1S5N 0959-3330 print/ISSN 1479-487X online
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htps/ W 5

Dans les cas suivants, I'importation ne s’effectue pas correctement :

I INTRODUCTION n-(D-YB)=0 (1b)
Recently, novel microwave photonic-bandgap (PBG) struetures where n is the unit vector normal to the surface of the per-
have been pmposed [1] Among those. the I.ll.liplELI.'lal' compact fect electromagnetic conductor and ¥ represents the admittance

photome-bandgap (UC-PBG) structure [2]. characterized by wide
Manuscript received March 01, 2010: accepted August 16. 2010, Date of pub-
lication October 21, 2010; date of current version November 12, 2010,
The authors are with the Poly-Grames Research Center. Department of

Manuseript received September 6. 2001, Electrical Engineering. Ecole Polytechnique de Montréal, Centre de Recherche
The authors are with the Electrical Engineering Department, Univer- en Electronique Radiofréquence (CREER). Montréal. QC. Canada H3T 114
itv of California ar Los Aneel Los Ay N I C-:’L 90032 USA ( il: (e-mai h.shahvarpour@ polymtl.ea).
sify of Calitornea at Los Angeles, Los Angeles, O LS A (e-mk Color versions . salibic figurcs in this paper are available onling

g ERTRITY
thlisher [tem Identifier 10,1109/ THMTT.2002. 802338

dhecexplore.icee.org.

izjtal Object Identifier 10,1109 TMTT.2010.20

0018-9480/02517. OISR
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ABSTRACT: An analviical expression for the admittance matrix of a
lossy composite rightfeft-landed transmission lime (CRLH-TL) based on
the Mittag-Leffler series expansion is presented, This expression can be
wsed o model @ perfodic CRLH-TL with an expansion truncated fo o
siall sumber of termis over a prescribed frequency range, which pro-
vides ihe transient response of the line in a faster and more efficient
manner than full fumped-element analvsis. A mumerical sivdy comparing
the adwittance parameters calcwlated using the ideal-TL infinitesimal
moled, the umped-element moded, and the Minag-Leffer expansion
{MLE) is conducted. The transient responses of ¢ CRLH-TL using ihe
Tumped-element model and the MLE are compared. © 2004 Wiley Peri-

odicals. Inc. Microwave Opt Technol Lea 43: 26-29, 2004 bt y
y InterScience (www.interscience. wiley.com M

Kev wards: fransmission fine; composite rightflefi-handed (CRLH)

sirweinre; reduced-order modefing

Important ! Pour ces derniers cas, il est possible de copier et coller le DOI dans une nouvelle référence et
d’utiliser la commande Find Reference Updates... (voir page 25) pour retrouver les informations
bibliographiques nécessaires.

EndNote offre la possibilité d’importer un PDF a la fois ou un dossier de fichiers PDF dans une banque.

Voici les étapes a suivre :
1. Dans EndNote : choisir File > Import - File... ou File > Import - Folder...

W N

Sélectionner le fichier PDF a importer dans Import File: ou le dossier a importer dans Import Folder:.
A la ligne Import Option:, aller chercher le filtre PDF.

A la ligne Duplicates prendre Import All et & Text Translation choisir No Translation. Cliquer sur
Import.

5. Chaque référence créée aura automatiguement comme piéce jointe son fichier PDF importé.

EndMote X9 - [Sample_Library_X9.enl]

File Edit References Groups Tools Window Help

MNew...

Open Library...

Open Shared Library...

Open Recent
Close Library
Save

Save As...
Save a Copy...
Revert
Share...
Export...
Import

Print...
Print Preview

Print Setup...

Compressed Library (.enk) ...

Exit

4 e
Ctd«s0 P——————
Ctrtl+shift+0 "
, 8, Z.A; Obozova,
cuew LA
culis Y. Franz, M. Q.; & | il , X
trl+
Y.; Franz, M. O,; mpeort File :
ebe, L. 2
Jennifer; Shackel Import File: Choase. ..
ayern, A. M. P; H.
[ Bovet, - 4 pE______ |
- - {  Import Option: | V|
> File.. \ 1 /
- Folder... : Duplicates: Import All i 3
L AHVIEr, R !
T Rana, R. S.; M Text Translation: Mo Translation 4 y ~
ova, A A
ova, A A Import Cancel
Ctrl+Q e
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IMPORTATION AUTOMATIQUE DE FICHIERS PDF

Al'ouverture de la banque EndNote, le paramétrage de I'option « PDF Handling » permet le téléchargement
automatique des fichiers PDF qui se trouvent dans un dossier choisi. Si la référence existe déja dans la
banque, EndNote ne créera pas de nouvelle référence, mais y joindra le PDF.

Voici les étapes a suivre :

1. Dans EndNote : choisir Edit > Preferences - PDF Handling.

2. Sélectionner une des options de changement automatique des noms des fichiers PDF qui seront
importés.

3. Cocher Enable automatic importing.

4. Cliguer sur Select Folder, sélectionner un dossier et faire OK. EndNote importera seulement les fichiers
PDF qui se trouvent a la racine de ce dossier.

5. Les fichiers PDF importés seront déplacés dans le sous-dossier « Imported » créé par EndNote dans le
dossier choisi.

e EndMote X9 - [Sample_Library_X9.enl] — O
& File Edit Re _ . »
EndMote - . o
® & | 4 b 2| @
—_— - ChangeCase E— 75
My Libra ry . Display Fields PDOF Auto Renaming Options | ~
i Al Bofora ! .. Display Fonts () Dont Rename Rechercher un dossier X
- Duplicates
p 2
é Search Resu - Find Full Text l (®) Author + Year + Title PDF Auto Import Folder
. - Folder Locations f Authar + Title
& Configure <. _
. Formatting () Author + Year - Bureau &
ORecently | 1 LLibmies | O e 2 Stéphanie Boswell
. = - PDF Handling " |
EJ Unfiled - Read / Unread O Custom v CePe
= ! I Bureau
W Trash . Reference Types -
. Sorting v = Documents
= Avian Intel . Spell Check BookWhere
@ prvianCe Sync Mote: Filenames may be Filtres EN
- Temporary Citations =/ Images
E_’CDW'CIS ... Term Lists lrnanee likre Arait R
. € >
. Corvids | . URLs & Links POF Auto Import Folder 4
cré dossi oK ' anru
E_’ Parrots 3 Enable automatic impon ST LN NOUVESL BossIEr :\I MUEr
1
" "WGENIED . polymtl catprofiles p 107355 doc § Select Folder Y
=" New Group | sification from
4(3),
- Bats 3)
B Chiropte
=|
= Echolocz EndMote Defaults Rewvert Panel oK Annuler Appliquer

.Ff’fhﬂlﬂf’f&unn L S | ™

Showing &0 of 60 references,

|E| Layout -
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TROUVER LES MISES A JOUR DES REFERENCES

La commande Find Reference Updates peut trouver des mises a jour pour une référence ou pour plusieurs
références sélectionnées en méme temps. Les informations additionnelles détectées sont présentées dans
la fenétre Review Reference Updates.

Pour mettre a jour une ou plusieurs références :

1. Ouvrir la référence ou sélectionner la ou les références a mettre a jour.

2. Faire References = Find Reference Updates... pour ouvrir le dialogue Review Available Updates.

3. Toutes les mises a jour sont surlignées en bleu dans Available Updates et My Reference. Pour les
mises a jour trouvées pour une notice, les options Update All Fields et Update Empty Fields sont
disponibles. Update All Fields va copier tous les champs de la mise a jour dans la référence initiale et
Update Empty Fields va copier les informations supplémentaires seulement dans les champs vides de
la référence initiale.

Les mises a jour peuvent aussi étre copiées et collées un champ a la fois de la colonne Available

Updates dans les champs respectifs de la notice My Reference.
4. Sauvegarder en cliquant sur Save and Continue.

- [Sample_Library_X9.enl]

References  Groups Tools Window Help

MNew Reference Ctrl+M G [

=1 A
Edit References Ctrl+E -
Mowe References to Trash Ctrl+D Title
GO Cile)  20ZOVa, .. Newda
Copy References To > Animal
E-mail Reference M. O.; S.. Plantcli
File Attachments M. O, S... Plant cl 1
PDF Viewer » An auto
Find Full Text > Bhackel.. The Oxf
Find Reference Updates... 2 ] M. P H The role
URL P bneAn s e

&4, Review Available Updates for Reference 1 of 1 Selected - [Yowvel, 2008 #59]

*

The available updates are shown on the left and highlighted in blue. "Update All Fields” copies every updated field from the Available Updates to My Reference, replacing
anything already existing in the field(s) in My Reference. "Update Empty Fields" copies available updates only when the corresponding field in My Reference is blank. Text can

also be manually copied and pasted into fields.

Available Updates

Title

Plant classification from bat-like
echolocation signals

Journal

PLoS Comput Biol

Reference Type: Journal Article

3

Update Al Fields -=

Update Empty Fields k

Edit Reference -

My Reference

Title

Plant classification from bat-like
echolocation signals

Journal

PLoS Computational Biology

Volume Volume

4 4

Part/Supplement Part/Supplement

Issue Issue

3 3

Pages Pages v

Cancel
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LIEN AVEC LE TEXTE INTEGRAL D’UN ARTICLE DE REVUE OU DE CONFERENCE

Ce paramétrage permet de faire le lien entre la référence et le texte intégral de I'article lorsqu’il fait partie
de nos collections ou de publications gratuites. Il meéne a Colombo, notre systeme de prét entre
bibliotheques, si I’article n’est pas disponible.

Pour effectuer ce paramétrage :
1. Edit = Preferences.
Sélectionner Find Full Text.
Cocher OpenURL.
Inscrire https://polymtl.on.worldcat.org/atoztitles/link dans la boite OpenURL Path.
Trés important! Désélectionner Automatically invoke Find Full Text on newly-imported references

vk wnwe

et cliquer sur OK.

Les banques de données ne permettent pas |'utilisation des robots Web (crawlers) pour accéder a leur
contenu et pour télécharger des articles d’'une maniére systématique.

Par conséquent, la commande Find Full Text et 'option Automatically invoke Find Full Text on newly-
imported references ne doivent pas étre utilisées.

B4, EndMote X9 - [Sample_Library_X%.enl]

©, File  Edit References Groups Tools Wind EndMNote Preferences x
D @ Undo Ctrl+Z Ch c
o ange - ase The Find Full Text feature uses several technologies to maximize the
My Lib Cut Ctrl+X - Display Fields chances that EndMNote will find all available PDFs. Use this screen to
y L . Display Fonts contral these full text search options:
J Copy Ctrl+C ’ 2
Paste Chrl+V [] Web of Science Full Text Links
@ Cory Paste With Text Styles - Folder Locations DOl (Digital Object Identifier)
DRece  Clear -~ Formatting [ PubMed LinkOut (UU.S. National Library of Medicine)
- Select All Ctrl+A - Libraries 4
B unfi
i ]
Copy Formatted Ctrl+K -~ PDF Handlin 3 R OpenURL
’?"Tras g - Read / Unreaa
- Find and Replace... Ctrl+R ’ I OpenlURL Path: |l‘rl'tps:ﬂpoh'rntl.on.worldcat.orgfatoztitlesﬂink I
.. Reference Types
B (| .
Lol Font 2 -~ sorting Authenticate with:
@, T y .. 5pell Check
- Sync URL: | |
E_’ ( Style » T Citati
empo.rar}r itatiens Examples: https://login ezproxy library myuniversity edulogin
@« Output Styles > -- Term Lists http://auth universityname edu/authentication
=TT Import Filters 5 -- URLs & Links
Topme=iem F= 1 s 5 I [ Automatically invoke Find Full Text on newlyimported references I
="New Preferences... h N /
EndMNote Defaults Revert Panel Annuler Appliquer
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https://polymtl.on.worldcat.org/atoztitles/link

Pour obtenir le texte intégral d’'une référence d’article de revue :

1. Sélectionner la référence d’article de revue désirée.
2. Cliquer sur References = URL = OpenURL Link.
OU Sélectionner la référence = cliquer sur le bouton droit de la souris 2 URL 2 Open URL Link.

- [Sample_Library_X%.enl]
References  Groups Tools Window Help

Mew Reference Ctrl+M @ @ ‘ IEI ’___Eﬁ\?

Edit References Ctrl+E

Maowve References to Trash Ctrl+D Title

Go To. Cie)  Dozova, .. New data on the
Copy References To > Animal intelligen:
E-mail Reference M. Q. 5. Plant classificatio

File Attachments > 1
PDF Viewer > An autocorrelatio
Find Full Text * Ehackel.. The Oxford handl
Find Reference Updates... \ & ~f avhar
URL ¥ OpenlURL Link 2
Figure ¥ Open URL Ctrl+G [
Wb f Crian-a _} ' 7

JOINDRE L’ADRESSE INTERNET PRESENTE DANS LE CHAMP URL D’UNE REFERENCE

1. Sélectionner la référence ciblée.
2. Cliguer sur I'icone Open Link dans la barre d’outils.

|-:| ® | AP‘AE:th_fr_F‘ol],rI".*I'I'IL - gl AR D | (] B E.;E|| () Sk ;

ou
1. Sélectionner la référence > cliquer sur le bouton droit de la souris > URL = Open URL.

JOINDRE DES FICHIERS A UNE REFERENCE

EndNote offre la possibilité de joindre des fichiers a une référence. Par exemple, le texte intégral des articles
en format PDF, des fichiers texte et des images peuvent étre joints a une notice.

Sélectionner la référence ciblée et cliquer sur le bouton droit de la souris.
Faire File Attachments - Attach File...
3. Choaisir le fichier respectif et cliquer Ouvrir.
ou
1. Double-cliquer la référence ciblée pour I'ouvrir.
Glisser — déposer le fichier a joindre dans la référence.
ou
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1. Double-cliquer la référence pour I'ouvrir.
2. Cliquer sur l'icone du trombone.
3. Sélectionner le fichier respectif.

* * Reference Elttached PDFs @
—
I_EH ‘ E‘,‘ O\.| @Q‘ E} E.:-;E‘ Plain Font ~ Plainsize ~

B I UP AAZ A-

Pour conserver dans votre banque des copies de tous vos fichiers PDF joints aux références dans le sous-
dossier .PDF du dossier .DATA :

1. Edit = Preferences.

2. Sélectionner URLs & Links.

3. Sélectionner Copy new file attachments to the default file attachment folder and create a relative

link et cliquer sur OK.

Si vous voulez simplement avoir un lien vers la localisation sur votre ordinateur du fichier PDF joint et non
une copie intégrée dans la banque EndNote :
3. Décocher Copy new file attachments to the default file attachment folder and create a relative link
et cliquer sur OK.

4, EndMote X9 - [Sample_Library_X9.enl]

EndMote Preferences x
B4 File = Edit References Groups Tools  Wind
- Change Case )
D @ Undo Ctrl+Z - Display Fields Connection Log
—— Cut CrleX - Display Fonts Use Log File
My Lib D-Llp|ICEtES |C:'-.Users'-p1D?355'-ﬁppData'-.Roaming'-.EndNoie'-.Conneci
- Copy Ctrl+C - Find Full Text
" .
Al Paste Cri+V E'D'de't';_“atm”s IS| Base URL
O - - ) -- Formatting
& Con Paste With Text Styles .. Libraries ||'rl‘tp:f’fgateway.isiknowledge.comfgatewanyateway.cgi
O Rece Clear . PDF Handling
. R - Read / Unread CpenlJRL Arguments
- Select All Ctrl+ A
E_’ Unfi - Reference Types - - -
Copy Formatted Ctrl+K  Sortin Zsid=I3|:WoSdaufirst=AUFIRSTaulast=AULAS Téissn=|
T Tras ! g 5SNgisb=ISBNatile=ATITLEitle=TITLESvolume=VO
= Find and Replace... Ctrl+R - Spell Check LUME3issue=IS5UEAdate=DATE&spage=5PAGEAepag
. - Syne
= Aviz Font > - Temporary Citations
. O Copy new file attachmerts to the default file attachment folder
.,{ Size ] 1 and create a relative link. 3 '
Style 3 2 URLs & Links Mote: Find Full Text copies full text to the default attachment folder
E_! ( § even if this setting is not selected.
@ Cutput Styles >
E_” Impeort Filters >
Connection Files »
=" Nev Preferences.. |-, 1 )
EndMote Defaults Revert Panel Annuler Appliquer
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ANNOTER LES FICHIERS PDF JOINTS A UNE REFERENCE

Sous EndNote X9, il est possible de visionner et d’annoter les fichiers PDF joints aux références sous I'onglet
« Attached PDFs ».

La barre d’outils sous cet onglet (PDF Viewer Panel) comprend Highlight Text (surligner le texte), Sticky Note

(ajouter un commentaire) et Find (rechercher un terme ou une expression dans le texte du PDF affiché).

Reference | Preview @Goto-zmz-Large-billed crows (Corvus macrarhyn,pdf ‘ @

FEaX| ¢ & -sle@nm%v@%@?uﬂm\

Barre d’outils PDF Commentaire Surligner Rechercher
(Sticky Note) (Highlight Text) (Find)

Pour ajouter un commentaire :
1. Sélectionner Sticky Note =] sur la barre d’outils de I'onglet « Attached PDFs ».
2. Placer le curseur dans le texte du PDF a I'’endroit ou insérer le commentaire et cliquer. (Si désiré,
sélectionner le texte et le surligner avec Highlight Text avant de cliquer sur Sticky Note.)
3. Saisir I'annotation dans la petite fenétre qui apparait.
4. Cliquer sur Save PDF ou fermer la petite fenétre et enregistrer le commentaire.

Reference | Preview @Goto-ZDﬂ-Large-b\lled crows [Corvus macrorhyn.pdf | @ 1 5

ZEaR 432 500w B BT

4

rerrace and Son {2009)

28 3 Anim Cogn (2012) 15:27-35
These nonverbal tests % ults revealed that monkeys indeed chose the “low” confi-
consist of a primary task ¢ nce icon more frequently after incorrect than correct

to uncertainty or confidence. The test of sensitivity to  searches. Moreover, without additional training, these ret-

uncertainty or confidence can be given before, during, » spective metacognitive responses could be transferred to
after answering the primary memory test, and they conn| 2  Wly introduced numerical and perceptual discrimina-
spond to prospective, concurrent, and retrospective meta. «40ns, as well as a serial probe recognition task (Kornell e

Pour surligner en jaune une partie du texte, la sélectionner et cliquer sur Highlight Text. Pour éliminer le
marguage du texte, le sélectionner puis cliquer avec le bouton droit de la souris et choisir Delete Annotation.
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PRODUCTION AUTOMATIQUE D’UNE BIBLIOGRAPHIE

Le lien entre Word et EndNote doit étre fonctionnel et releve des procédures d’installation.

La présence de I'onglet EndNote dans la barre d’outils de Word indique que le lien est fonctionnel.

H O 0 - Document] - Word

Fichier Accueil Insertion Création Disposition Références Publipostage Révision Affichage Antidote
[]] %, Go to EndMote Style:  APAGth_fr_PolyMTL - ﬁ# Categorize References = Export to EndMote ~ o
- E‘}‘ Edit & Manage Citation(s) I_E,l Update Citations and Bibliography Instant Farmatting is On = ﬂﬂﬁManuscript Matcher Help

Citation ~ E;';;.Edit Library Reference(s) 2 Convert Citations and Bibliography - EPre‘Ferences

Citations Eibliography P Toals

GENERER UNE BIBLIOGRAPHIE INDEPENDANTE A PARTIR DE REFERENCES DE VOTRE
BANQUE ENDNOTE

Dans EndNote :
1. Sélectionner les références désirées.
2. Afficher ces références avec References > Show Selected References.
3. Choisir Edit > Copy Formatted.

- [Sample_Library_X3.enl] ote X - [Sample_Library_¥9.enl]
References Groups Tools Window Help Edit | References Groups Tools  Winc

MNew Reference Ctrl+M Und CrleZ
Edit References Ctrl+E e i
Move References to Trash Ctrl+D Cut Ctrl+ X Accueil
Go To... Ctrl+J alls T

Copy Ctrl+C ~auper
Copy References To PR

= W Lopler
E-mail Reference Paste Ctrl+V Colle " ol
e WA les - Reproduire la
File Attachments Paste With Text Styles P
PDF Viewer Clear Presse-papier
Find Full Text Select All Ctrl+A 4
Find Reference Updates... Copv For ed Crls K
URL L) Sibl : Py b
= - 1DIEY... Find and Replace... +R
igure > ; 3 \
d A Kir..
Web of Science ¥
MNext Reference Ctrl+Page Down ), g- FLIj...
Previous Reference Ctrl+Page Up T.1
Show All References ‘M
. o ur M.
Show Selected References l} )
2 ' Ahe S
Dans Word :

4. Cliguer Accueil et choisir Coller. Les références s’afficheront dans le style bibliographique choisi
ou
Dans EndNote :

1. Sélectionner les références.

2. Afficher ces références avec References - Show Selected References.

3. Faire File > Export..., choisir le type de fichier et le style bibliographique et enregistrer le fichier.
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INSERER UNE CITATION DANS UN DOCUMENT WORD

Attention : Ouvrir le fichier Word et votre banque EndNote.

. Dans votre banque EndNote, sélectionner la référence a ajouter dans votre document Word.

2. Dans le texte de votre document Word, positionner votre curseur a I’endroit de la citation.

. Sélectionner I'onglet EndNote X9, puis cliquer sur la loupe Insert Citation et choisir Insert Selected
Citation(s).

. La référence s’insere alors dans le texte a I’endroit ou se trouve le curseur selon le style choisi et une
liste de références (ou bibliographie) se crée a la fin du texte.

Fichier

H -0 @

Accueil

&%) EndMote X9 - [Sample_Library_X9.enl] — [m] x
e, File Edit References Groups Tools Window Help - & x
O® | APABER_fr_PolyMTL - E} ® L 4R | | [»] £} wE | Q S -l @ | Quick Search a - ’
My Library |" ® vear Author Title J 1 Reference Type 4
All References (60) 1999 Pepperberg, I. M. Rethinking syntax: A commentary onE... A /ning.. Journal Article
& Search Results ™ 2 1999 Pepperberg, Irene M. The Alex studies: Cognitive and commu...
@ Configure Sync... 2009 New York State Depart.. Guidelines for conducting bird and bat s... Gavernment Docum
DRecently Added @ 2003 Moss, C.F; Sinha, 5. R, Neurobiology of echolocation in bats Current Opinion.. Journal Article
2008 Lefebwvre, L; Sol, D. Brains, lifestyles and cognition: Are ther..  Brain, Behavior .. Journal Article
By unfiled (10) ) ) .
2010 Laudato, Anthony Bird grooves to the beat CBS Sunday Mo.. Online Multimedia
W Trash (0)

=~ Avian Intelligence
@ Avian Cogniti.. (29)
B Corvids A7)
@ Corvids & Parr... (5)

Biparrnte P Y

Showing 60 of 60 references.

Insertion Création Disposition

2008 Jen. P. H. S:Wu. C. H. Echo duration selectivitv of the bat varie.. Meuroreport Journal Article ~
>

4l

H -0 @ -
Fichier
— N

b2

Insert
Citation = E}';(. Edit Library Reference(s)

sts. Cambridge, Mass.:

Accueil Insertion Création Références

Dispaosition

EN, Go to EndMote
[ Edit & Manage Citation(s)

Style: | APAGth_fr_PolyMTL -
E,'- Update Citations and Bibliography
B2, Convert Citations and Bibliography =

|E| Layout °

E Insert Citation...
2 )"h Insert Selected Citstion(s)
¢ E Insert Note...
E.gf Insert Eigure...

Bibliography

|-2-|-1-|-§-|-1-

Document] - Word

Références Révision Antidote EndMote X9 ACROBAT

Publipostage Affichage Q Ditesn

93 &, Go to EndNote Style: | APASth_fr_PohyMTL - E):— Categorize References ~ Export to EndMote - o

Mo F",‘Edlt&ManageCltat\on(s) E,'-Update(ltat\ons and Bibliography Imstamt Formatting is On - ﬂﬂqlManuscnpt Matcher Help
e E*‘ Edit Library Reference(s) %, Convert Citations and Bibliography = E Preferences

Citations Bibliography [ Tools

L |-Z-\-1‘|‘§‘|-1-|-1-\-J- SA 50 B0 T 0 B0 90 100 111 120 D30 14 g 151 16 PudTen (180 19
~
-
: 3

Ceci-est-un-exemple-de-citation-(Pepperberg,-19593).9
1

Bibliographief]

1 4
Pepperberg,.-M.-(1999).-The-Alex-studies:-Cognitive-and-communict,
Cambridge,-Mass.:-Harvard-University-Press.q|

£s-of-grey-parrots.-
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APPORTER UNE MODIFICATION A UNE CITATION

1. Dans le texte, sélectionner la citation ol la modification doit étre faite. Elle apparaitra surlignée en
gris.

2. Cliquer sur I'onglet EndNote dans la barre des menus, puis sélectionner Edit & Manage Citation(s).

3. Pour enlever le nom des auteurs déja nommeés dans le texte, choisir Exclude Author.

4. Faire OK pour sauvegarder.

Document 1.docx - Word

H ©- [ =

ertion Création Disposition Références Publipostage Révision Affichage Antidote Endhi
Style:  APAGth_fr_PalyMTL - i} Categorize References = Expart to EndMote ~ e . : . .
= Citation(s) E‘ Update Citations and Bibliography Instant Formatting is On = Dﬂn_ManuscnptMatcher F|Ch|Er ACCUE” |nSEI"tIGr1
ference(s) E Caonvert Citations and Bibliography - E Preferences HEE
Bibliography [F] Toaols ,, E"J Gl:' t':' EndNDtE
E R ‘1‘.-5-.-1- V200 30 A 5 B T B 90 1D

| Q B3 Edit & Manage Citation(s]% 2
nsert
Citation = E‘ﬁ. Edit Library Reference(s)

Citations
Ceci est un exemple gui montre comment modifier une citation :
1 (Emery, Seed, von Bayern, & Clayh:m, 2007)
EndMote X9 Edit & Manage Citations X
=
Citation Count  Library

{Emery, Seed, von Bayern, & Clayton, 2007)
Emery, 2007 #2324 i Sample_Library_X9 Edit Reference | =

Edit Citation Reference

Formatting: | Default i
Prefix: D
Exdude Author 3 I
Suffix: Exclude Year
Exclude Author & Year = _a
Pages: Shaw Only in Bibliographr
Tools - Cancel Help

lotals: 1 Citation Groun. 1 Citation. 1 Reference

Note : Dans la fenétre EndNoteX9 Edit & Manage Citation(s), il est également possible d’exclure I’'année, d’ajouter du
texte en début ou en fin de citation, de mentionner les pages citées ou d’afficher la référence sélectionnée seulement

dans la bibliographie.

PERSONNALISER VOTRE BIBLIOGRAPHIE

1. Dans la barre EndNote, cliquer sur la fleche de la section Bibliography.
2. Choisir le style approprié sous With output style:.
3. Al'onglet Layout, ajouter I'intitulé de cette liste de références. Ex. : Bibliographie.

H -0 @ s Document 1.docx - Word
Fichier Accueil Insertion Création Dispasition Références Publipostage Révision Affichage Antidote EndNate X9
99 B, Go to EndMate Style: | APAGth_fr_PolyMTL - i)} Categorize References ~ = ~ EndMote -
M F",‘Edit&ManageCitation(s} E‘Updatecitations and Bibliography InstantFormat'ting isOn~ 1 \tMatcher Help
TFrelfam= E‘*Edit Library Reference(s) '!_'J,Cnn\fer‘t Citations and Bibliography = a /.,é;

L
Citations Bibliography Tools
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EndMote X9 Configure Biblicgraphy
Format Bibliography  Layout
Format document:

Documentl

With output style: l APASth_fr_PolyMTL

Temporary citation delimiters

Left: Right:

EndMNote X% Configure Bibliography
gr—

Format Bibhograph{

Layout l
A

" Font:

Times Mew Roman -
~ | | Browse...
Bibliography title:

Bibliographie|

3

Text Format...

i

l Link in-text citations to references in the bibliography I

Start with bibliography number:

[ underline linked in-text dtations

Annuler

Firstline indent: | 0.000 cm Line spacing:  |Single £
Hanging indent: Space after:

Mone b

Aide

Annuler Aide

CREER UNE BIBLIOGRAPHIE POUR CHAQUE CHAPITRE OU SECTION D’UN DOCUMENT

N =

. Cliguer sur Sections.

. Sélectionner Edit 2 Output Styles 2 Edit "nom du style choisi".

3. Choisir une des options suivantes :
- Créer une bibliographie compléte a la fin du document;
- Créer une bibliographie pour chaque section;

- Créer une bibliographie pour chaque section et une bibliographie compléte a la fin du document.
4. Enregistrer les changements a la fermeture du style.

o, EndNote X9 - [APAGth_fr_PolyMTL]

EM, File Edit References

Plain Font

-

Plain Size

- About this Style

.. Punctuation

- Anonymous Works
- Page Mumbers

itations
- Templates

- Ambiguous Citations
- Author Lists

- Author Mame

- Mumbering

- Sort Order

= Bibliography

Groups

-

Tools  Window Help

These options allow you to create multiple biblingraphies in a single Microsoft Word
document when using Cite While You Write (CWYW). According to the type of style you are
working with, choose how dtations should appear for each section and document,

Sections
() Create a complete bibliography at the end of the document

() Create a bibliography for each section

Continue numbering, or apply settings for disambiguation and repeated
ctations across sections

@ Create a biblingraphy for each section and a complete bibliography at the
— end of the document

Mumbering will continue, and settings for disambiguation and repeated
dtations will be applied across sections.

33

Bibliothéque - Polytechnique Montréal — Septembre 2020



ENDNOTE WEB

EndNote Web (http://www.myendnoteweb.com) offre un accés Internet a un logiciel de gestion de

références bibliographiques qui sont entreposées sur un serveur de la compagnie Clarivate et non sur votre
machine. Les membres de la communauté de Polytechnique peuvent se créer un compte EndNote Web. Les
fonctions simplifiées offertes permettent de sauvegarder et d’éditer des références bibliographiques. On
peut interroger la ou les banques créées et générer des listes de références dans plusieurs styles. Les
utilisateurs de LaTeX/BibTeX peuvent exporter des références en format .bib ou générer des listes de
références sans utiliser Word.

Il est possible de synchroniser ses banques EndNote et EndNote Web, y compris les fichiers joints.

Avantages d’'un compte EndNote Web :
- Aucune installation requise;
- Possibilité d’accéder a sa banque sans la sauvegarder sur son poste;
- Possibilité de partager sa banque en lecture seule et en lecture et écriture avec des collaborateurs;
- Possibilité de générer des listes de références;
- Possibilités d’exporter des références en format BibTeX.
Désavantages par rapport a EndNote X9 :
- Absence de champs tels que le volume, le numéro et la pagination dans le format bref;
- Limite de styles disponibles;
- Non-disponibilité des banques en cas de panne du producteur.
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OUTILS SUPPLEMENTAIRES

L’aide de EndNote X9 est disponible sous Help = Search for Help on, Help = Online User Guide, ou dans
C:\Program Files\EndNote X9\ EndNote.pdf.

Plusieurs cas d’utilisation et problémes requierent des solutions non présentes dans les outils et guides de
la Bibliotheque. Il est possible de faire appel aux personnes ressources dont les coordonnées apparaissent
dans la boite Personnes ressources sur la page d’accueil du guide EndNote.

LaTeX/BibTeX : Consulter le guide BibTeX de la Bibliotheque de Polytechnique.

Le producteur Clarivate met a la disposition des utilisateurs :
e Une foire aux questions ou FAQ : https://support.clarivate.com/Endnote
e Un forum de discussion : https://community.endnote.com/t5/EndNote/ct-p/endnote

35 Bibliothéque - Polytechnique Montréal — Septembre 2020


http://guides.biblio.polymtl.ca/endnote
http://guides.biblio.polymtl.ca/bibtex

	Fonctionnalités générales du logiciel EndNote (version X9)
	À propos d’EndNote
	Installation du logiciel EndNote
	Types de fichiers
	Ouverture et affichage
	Ouvrir une banque existante
	Créer une nouvelle banque
	Fermeture et copie d’une banque
	Affichage des barres et des champs
	Affichage des champs d’une banque
	Types de références dans endnote
	Types de documents et types de références
	Références
	Ouvrir une référence

	Styles
	Outils pour gérer votre banque
	Création de groupe
	Création de « Smart Group »
	Création d’un ensemble de groupes
	Supprimer des références
	Élimination des doublons
	Vérification des références
	Correction d’une référence ou correction en lot

	Quelques fonctionnalités de recherche dans votre banque EndNote
	Alimentation de la banque EndNote
	Saisie manuelle
	Connexion directe
	Importation directe
	Importation indirecte
	Importation manuelle de fichiers PDF
	Importation automatique de fichiers PDF

	Trouver les mises à jour des références
	Lien avec le texte intégral d’un article de revue ou de conférence
	Joindre l’adresse Internet présente dans le champ URL d’une référence
	Joindre des fichiers à une référence
	Annoter les fichiers PDF joints à une référence
	Production automatique d’une bibliographie
	Générer une bibliographie indépendante à partir de références de votre banque EndNote
	Insérer une citation dans un document Word
	Apporter une modification à une citation
	Personnaliser votre bibliographie
	Créer une bibliographie pour chaque chapitre ou section d’un document


	EndNote Web
	Outils supplémentaires

